
GemStone User Guide  

 

 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Updated 20 Dec 2019 

This guide is intended for GemStone version 2.0 and minor version updates. 

  

Copyright 2008-2019 by Verity Software House 

All Rights Reserved. 
  
  
  
  

 

Phone: (207) 729 6767 

Email: verity@vsh.com 

Web: www.vsh.com 

  

https://www.vsh.com/




i 

Table of Contents  

Quick Start Guide ................................ ................................ ................................ ...............  3 

1. Install and register your new soft ware... ................................ ................................ .......  3 

2. Take a quick look at the user interface and terminology...  ................................ ..............  3 

3. Try out a tutorial or two...  ................................ ................................ ...........................  3 

Further reading ................................ ................................ ................................ ..............  4 

License and Warranty ................................ ................................ ................................ .........  5 

Latest Versions ................................ ................................ ................................ ..................  7 

New Features in GemStone ................................ ................................ ................................ . 9 

System Requirements ................................ ................................ ................................ ........ 11 

Installation and Setup of GemStone ................................ ................................ .................... 13 

Registering your new software ................................ ................................ ........................... 15 

GemStone Terminology ................................ ................................ ................................ ..... 23 

GemStone User Interface ................................ ................................ ............................... 23 

GemStone User Interface ................................ ................................ ............................... 25 

The GemStone Workspace ................................ ................................ .............................. 27 

What is a Project? ................................ ................................ ................................ .......... 28 

The Project Library ................................ ................................ ................................ ........ 29 

What is a Template Document? ................................ ................................ ...................... 30 

Saving and Opening ................................ ................................ ................................ ....... 31 

Phenotype Naming................................ ................................ ................................ ......... 34 

What is a Probability State Model? ................................ ................................ .................. 35 

Tutorials ................................ ................................ ................................ ........................... 37 

Analyzing Files with an Existing Project ................................ ................................ ............ 37 



Table of Contents 

ii 

Analyzing Files with an Existing Project ................................ ................................ ............ 42 

Develop: Starting a New Project from Scratch ................................ ................................ ..47 

Develop: Adding Cell Types to the Project ................................ ................................ ........ 78 

Develop: Analyzing Subsets ................................ ................................ ..........................  107 

Develop: Exploring with Cen-se' ................................ ................................ ....................  127 

Develop: Additional Exercises ................................ ................................ .......................  149 

Develop: Finishing the Project ................................ ................................ .......................  154 

Stain Assessment ................................ ................................ ................................ .........  182 

Reference ................................ ................................ ................................ .......................  191 

Reference ................................ ................................ ................................ ...................  191 

File tab ................................ ................................ ................................ .......................  192 

Home tab ................................ ................................ ................................ ....................  209 

Insert tab  ................................ ................................ ................................ ....................  225 

Options tab ................................ ................................ ................................ .................  345 

Develop tab................................ ................................ ................................ .................  378 

Help tab ................................ ................................ ................................ ......................  450 

Batch Commands ................................ ................................ ................................ .........  457 

Cell Type tabs ................................ ................................ ................................ .............  472 

Users and Groups ................................ ................................ ................................ ...........  493 

Research and Compliance Modes ................................ ................................ ..................  493 

Research and Compliance Modes ................................ ................................ ..................  495 

Setting Up Compliance Mode ................................ ................................ ........................  497 

21 CFR Part 11 Compliance ................................ ................................ ..........................  501 

Index ................................ ................................ ................................ .............................  503 



3 

Quick Start Guide  

  

1. Install and register your new software...  

Installation and Setup of GemStone 

Registering your new software 

  

2. Take a quick look at the user interface and terminology...  

GemStone User Interface 

The GemStone Workspace 

What is a Project? 

The Project Library 

What is a Template Document? 

Saving and Opening 

Users and Groups 

  

3. Try out a tutorial or two...  

Analyzing Files with an Existing Project 

  

The Develop tutorials for creating your own projec ts: 

Starting a New Project from Scratch 

Adding Cell Types to the Project 

Analyzing Subsets 

Exploring with Cen-se' 

Additional Exercises 
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Finishing the Project 

Stain Assessment 

  

Further reading  

When you have a chance, review the Reference sections. 

Reference 
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License and Warranty  

  

License Agreement  

Copyright laws of the United States and international treaty protect this software. Verity 
Software House provides this software (the "Software") under the following conditions:  

Software is intended to be installed and used on one computer. An additional computer 
license is required for each additional installation. 

Network versions of software require one serial number for each simultaneous use. Network 
versions are intended for installation and use on a local area network; other uses are not 
supported. 

Backups of the software must be used only for archival purposes. 

Duplication of the manual is strictly prohibited without the expressed written permission of 
the copyright holder.  

If you transfer the use of this software to another party, that part y must accept the terms of 
this agreement, and you must transfer all copies of the software or destroy them.  

Your license to use this software will terminate if you are found to be in violation of this 
agreement. 

The laws of the State of Maine and the United States of America govern this license. 

  

Limited Warranty  

Verity Software House (VSH) warrants the physical media and the physical documentation, if 
included, to be free of defects in materials and workmanship for a period of 30 days from 
date of purchase. If VSH receives notice of defects in materials or workmanship within the 
warranty period, VSH will replace the defective media or documentation. 

VSH makes no other warranties, either expressed or implied, with respect to this manual or 
with respect to the software described in this manual, its quality, performance, 
merchantability, or fitness for any particular purpose. VSH software is licensed "as is". The 
entire risk as to its quality and performance is with the buyer. Should the software prove 
defective following their purchase, the buyer (and not VSH, its distributor, or its retailer) 
assumes the entire cost of all necessary servicing, repair, or correction and any incidental or 
consequential damages. In no event will VSH be liable for direct, indirect, incidental, or 
consequential damages resulting from any defect in the software, even if VSH has been 
advised of the possibility of such damages. Some states do not allow the exclusion or 
limitation of implied warranties or liability for incidental or c onsequential damages, so some 
of the above limitations or exclusions may not apply to you.  
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Latest Versions  

  

To find the latest versions for GemStone and the documentation, visit the Verity Software 
House web site at www.vsh.com. This site provides a complete version of the latest revision 
of the online documentation, patches, and technical support information for the program.  

You can also email us at verity@vsh.com to determine whether or not you have the lates t 
version. Please include the version that appears on the start -up dialog box, and the file date 
for the program with your email.  

The software also has a Check for Updates command in the Help menu. Use this command 
periodically to see if there are updates for your software. The command can download and 
install updates that are available, if you have administrative rights to your computer.  

https://www.vsh.com/
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New Features in  GemStone  

  

GemStone 2.0 is a totally redesigned application. While it is based on the same Probability 
State Modeling engine introduced with GemStone 1.0, the user interface and workflows are 
entirely different.  

And you will love the changes! 
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System Requirements  

  

NOTE: Your software will only run on the operating system you select  at the time of 
purchase.  

  

Minim um System Configurations  

If you purchased a Windows version:   
Windows 7, Windows 10 or greater, 3.40GHz CPU or better, 8GB RAM or greater, 8 or more 
logical processors, with 750MB free disk space for program files.   

  

If you purchased a Mac version:   
macOS 10.12 or greater, 3.40GHz CPU or better, 8GB RAM or greater, with 750MB free disk 
space for program files.   

  

Optimal Configurations  

Faster CPUs with more cores, high-speed SSD drives, and greater RAM will improve 
performance. 
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Installation  and Setup of GemStone  

  

IMPORTANT NOTES:  

¶ Your software will only run on the operating system you select  at the time of 
purchase.  

¶ Stand -alo ne versions of the program are designed to be  installed and 
registered on a single computer . 

¶ You must have administrative rights to the computer during installation and 
registration of the software. After registration, the program can be run by users with 
restricted access to the computer, as long as the program is installed in a location 
where users have read/write permissions. 

¶ You will need to register the software with Verity Software House in order to unlock 
the program on the computer. This can be done  using the online registration process 
or by contacting technical support.  

¶ If your program is an update version, you  will need the serial number for the previous 
version to register and unlock the software.  

¶ If your program is an additional computer license , you will need the serial number for 
the primary license to register and unlock the software.  

  

Windows Version  

Ins tallation  

¶ Log on to your computer with an account that has Administrator privileges. You must 
have administrative rights during installation . 

¶ If you downloaded the software, extract the installation files from the download into a 
temporary folder. If you h ave an installation CD, insert the program CD into the CD-ROM 
drive. 

¶ Run the program named GemStoneSetup.exe . Follow the directions on the screen to 
complete the installation. 

¶ See the section on registering your software for information on how to register your 
software. 

Using the software  

¶ Log on to your computer with your own user account. This should be the account that 
you normally use on the computer.  

¶ Open the Start menu and navigate to the Verity folder. Choose GemStone 2.0 . 

  

Mac OS Version  
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Installation  

¶ Log on to your computer with an account that has Administrator privileges.  You must 
have administrative rights during installation.  

¶ The installer is distributed as a disk image, or "DMG" file. Double-click the DMG file to 
mount and open the disk.  

¶ A Finder window will display program icons and instructions for how to install the 
program. Follow those directions to complete the installation.  

¶ See the section on registering your software for information on how to register your 
software. 

Using the software  

¶ Log on to your computer with your own user account. T his should be the account that 
you normally use on the computer.  

¶ In Finder, navigate to the Applications folder.  
¶ If there is  a GemStone  shortcut in the Applications folder, double -click it to start the 

program. 
¶ If there is no GemStone shortcut, open the GemStone 2.0  folder, and then the 

Application subfolder. Double-click the GemStone 2.0  application icon. 
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Registering your new software  

  

Why You Should Register  

Registration is a key step in setting up the software to run on your computer. In fact, your 
software will not be fully functional until you register . Here's why. 

This version of the program uses software security, which requires you to register your 
software in order to receive an Unlock Code  to make the program fully functional. An 
unregistered installation will be fully functional for 30 -days, and then become a "trial version" 
with limited functionality until it is registered.  

Of course, registration is useful for other reasons, too. We can inform you of bug fixes and 
updates, and provide you with bet ter technical support. 
  

How to Register  

When you start the program for the first time, it will automatically start the Registration 
Wizard. You can access this dialog at any time by clicking the Registration button on the 
dialog box that is displayed when the program starts up.  
  

 
  
Click the Next  button to begin the registration process.  
  



Registering your new software 

16 

 
  
The wizard will ask how you want to register the program. Select  the appropriate option and 
click Next.  
  

 
  
Then next step in the wizard shows some information about the program. There are 3 fields 
that you need to fill in for this step: Serial #, CD Key, and Your Email. You can also enter or 
edit the Computer Name field to identify your computer.  
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The Serial number and CD Key can be found on the outside of the pro gram box or in email if 
the program was provided to you by download. Enter these exactly as they appear; they are 
case-sensitive. If you have lost or misplaced the Serial number or CD Key, contact Verity 
technical support at tech@vsh.com or (207) 729 6767. 
For the Email field, make sure to enter your valid email address. Otherwise, you may not 
receive the Unlock Code and the program will not be fully functiona l. 
Click Next  to continue the registration process.  
  
If you have not yet created a user account on  vsh.com, a user account wizard is displayed. 
This step only appears if you have not yet created a user account. 
Fill in all fields on the form and click Next . 

 
  
If you have more than one user account at vsh.com, you will be presented with another step. 
This step only appears if you have more than one account. 
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Choose the web account that you want to use for registration, and then click Next . 
  
At this point, the program will request an unlock code from the registration server at 
vsh.com. If successful, you will see the confirmation step and the Unlock Code for  your 
computer. 
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You can print the registration information by clicking the Print  button. Click Finish  to close 
the wizard and continue working with the program  
  
If there was a problem with the registration, an informative message will explain the pr oblem 
and steps to take to correct it.  
  
Once you have completed the registration successfully, the program will be fully functional.  
  
  

If the registration wizard cannot connect to vsh.com  

Sometimes firewalls can prevent the registration wizard from conn ecting to vsh.com. In this 
case, you can try registering with your browser. Choose the second option in the list and click 
Next  to launch your browser with the correct registration information.  
  

 
  
Follow instructions on screen to complete the process. 
  

To register your software using email  

The registration wizard can help you send email to Verity Software House with your 
registration information. Choose the third option in the list and click Next  to create an email 
message. 
  



Registering your new software 

20 

 
  
Follow instructions on screen to complete the process. 
  

To register your software using another computer...  

When the installation computer does not have internet access but another computer does, 
you can use the fourth  option in the list and click Next  to begin the pr ocess. 
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On the installation computer, write down the Computer ID displayed in the 
Register Software dialog . 

Next, go to the computer that has Internet access, launch a browser, and navigate to 
www.vsh.com. 

Click the Register Software  link. 

If you already have a web account, login with your user name and password.  If you do not 
have a web account, create a new account that will be associated with this registrati on. 

After you login, the Software Registration  page will be displayed on the web site.  Fill in 
the information in the form on this page to register the product. If you are registering an 
update version, you will need the serial number of the previous vers ion to complete the 
registration. If you are registering an additional user license, you will need the serial number 
of another copy of the program that is registered to your institution.  

Getting an Unlock Code is a two-step process. First, you fill in and  submit the registration 
form on the web site. This sends a registration request is sent to Verity. Your Unlock Code is 
then emailed to you, so make sure you provide a valid email address. 

When you receive your Unlock Code via email, paste or type it into the Unlock Code field in 
the Registration dialog box on the installation computer. When possible, use Copy and Paste 
to do this, to ensure that the characters are correct. Then click the OK button.  

Your program will become fully functional once the Unlock Code is entered correctly. 

  

If you do not have Internet access  

If you do not have access to the Internet, you can send the registration information below to 
Verity Software House by fax, mail, or telephone. Our technical support staff can register the 
software for you with the information you provide, and supply you with the Unlock Code to 
enter into the Registration Wizard. 

Here is the information we need. You can print this page and fill it in.  

These fields are found in the Registration dialog box. 

Program Name: 
Program Version: 
Computer ID: 
Serial number: 
CD Key: 

User Information 

Name: 
Institution:  
Address: 
City: 
State/Province: 
Zip/Postal Code: 
Country: 
Phone: 

https://www.vsh.com/
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Fax: 
Email: 

Our technicians will use the information below to create a web user account for  you on our 
web site. 

Name to use on VSH web: 
Password to use on VSH web: 
A question we can ask to verify who you are:  
The answer to the question to verify who you are:  

If you are updating from a previous version, you will need to supply the serial number of the 
previous version. 

Serial Number of previous version: 
  

Contact Verity Software House  

Verity Software House 
PO Box 247, Topsham, ME 04086 
USA 
 
Email: verity@vsh.com 
Web: www.vsh.com 
Phone:  (207) 729 6767 
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GemStone Terminology  

GemStone User Interface  

  

When GemStone starts-up, the main window is comprised of a ribbon bar at the top, a batch 
list on the left, and a report tab that contains tabs for each page in a report.  

 

  

The ribbon bar contains most of the commands that you will use.  The commands are divided 
into a series of ribbon tabs: File tab, Home tab, Insert tab, Options tab, Develop tab, and the 
Help tab.  Some tabs are only visible when the Develop option is enabled. 

  

Develop Mode  
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In Develop mode, additional elements are displayed: 

 

  

Additional ribbon tabs are displayed in Develop mode.  Batch commands determine what 
actions are performed on files in the batch.  Additional tabs appear at the bottom of the 
window to select FCS File, Cell Types, and Maps view.  With the Cell types view selected, a 
tab is shown for each cell type defined in the model templ ate. 
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GemStone Us er Interface  

  

When GemStone starts-up, the main window is comprised of a ribbon bar at the top, a batch 
list on the left, and a report tab that contai ns tabs for each page in a report.  

 

  

The ribbon bar contains most of the commands that you will use.  The commands are divided 
into a series of ribbon tabs: File tab, Home tab, Insert tab , Options tab, Develop tab, and the 
Help tab.  Some tabs are only visible when the Develop option is enabled. 

  

Develop Mode  

In Develop mode, additional elements are displayed: 
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Additional ribbon tabs are displayed in Develop mode.  Batch commands determine what 
actions are performed on files in the batch.  Additional tabs appear at the bottom of the 
window to select FCS File, Cell Types, and Maps view.  With the Cell types view selected, a 
tab is shown for each cell type defined in the model template.  
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The GemStone Workspace  

  

The GemStone workspace is a folder on disk where the software is installed.  The folder 
contains key components of the program in sub-folders that store the progra m itself, the user 
guide, the Project library, and other important parts of the software.  
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What is a Project?  

  

The term "Project" in GemStone refers to collection of files that d etermine an analysis 
approach. A Project includes one or more model templates that are used to analyze FCS 
files.  It includes one or more batch scripts that determine how to load FCS files and model 
templates, what operations to perform on the FCS files, and the outputs of the analysis such 
as PDF files and databases.  A Project contains the FCS files added to it, and the output files 
it generates. 

Projects provide a simple way to design an analysis strategy and to manage the related 
files.  On disk, a Project is organized as a set of folders and files. 
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Project  

The Project Library  

  

The Project Library is part of the GemStone Workspace that contains the Projects that can be 
used for analysis, including those that you create.  Each Project is a folder which contains 
additional folders of information.  

The example below shows Projects that have been created: 16 Color Demo, Exp 1 10-Jan-
2018, and Exp 2 17-Jan-2018.  The folder structure of one of the Proj ects is also shown. 
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What is a Template Doc ument?  

  

A template document contains the cell type definitions, expression profiles, report design, 
and objects on the cell type canvas. It is the underpinning  of the analysis system - the 
Probability State Model.  This component of the software is only accessible in Develop mode. 

  

A template document defines a set of cell types.  Each cell type is defined by a set of 
expression profiles for the key markers of the cell type.  For example, a CD8 cell type is 
typically defined with expression profiles for CD3, CD66b, CD19, CD8, CD4, and other 
markers.  The cell types can include staging related to the cell t ype, as well as graphical 
elements like 1P and 2P plots, overlays, and more. 
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Saving and Opening  

  

GemStone has many different types of items that can be saved and opened.  Here's an 
explanation of the primary open and save operations that you will encounte r in the software.  

  

The Home tab, Develop tab, and File tab of the ribbon are used for saving and opening:  

 

  

 

  

Projects  

When you open or save a Project, the program opens or saves the batch commands and 
database fields for the method.  The batch commands determine what template documents 
are used, what kinds of out put to save (PDF, analysis documents, etc.), and what to print.  

  

Command  
Where 
Is It?  

Function  

 

  

File 
menu,  
Develop 
tab 

Save the current method in the 
Project Library  folder.  In 
Develop mode, it will also prompt 
you to save the template 
document. 

 

  

Home 
tab 

This dropdown list displays all of 
the methods in the Project 
Library .  It opens the selected 
method. 
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File 
menu 

The Open Project command 
allows a method to be opened 
from outside of the Project 
Library .  

  

Analysi s Documents  

An Analysis document stores the analysis of an FCS file with a template document. Typically, 
this is saved automatically in the Fitted Models folder by the batch commands.  The user can 
also manually save and open analysis documents for review. 

  

Command  
Where Is 
It?  

Function  

 
  

Home tab 
Saves the current analyzed document to the current 
method's Fitted Models folder. 

 
  

Home tab 
Opens an analysis document from the Fitted Models  
folder or other location.  

  

Template documents  

A Template document stores the probability model definition. These files are only accessible 
in Develop mode.  Templates are stored in the Model templates folder of the method.  The 
Develop mode user can also manually save and open template documents. 

  

Command  
Where Is 
It?  

Function  

 
  

Develop tab 
Saves a template document to the current method's Model 
Templates  folder. 
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Develop tab 
Opens a template document from the Model Templates  
folder or other location.  
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Phenotype Naming  

  

Each marker for each cell type has a Phenotype field.  The field shows up in the Cell Type 
Wizard and on the Expression Profile properties.  Use this field to describe the marker 
expression for the cell type. 

The recommended syntax for this field is to use the short name of the marker (e.g. CD8), 
with one of the fo llowing appended: 

Symbol    Meaning  

+  plus symbol Positive expression of the marker  

-   minus symbol Negative expression of the marker  

dim  text Dim expression of the marker 

+> - 
plus, greater 
than, minus 

Transition of positive to negative expression of the 
marker 

->+  
minus, greater 
than, plus 

Transition of negative to positive  expression of the 
marker 

  

The values in the Phenotype field are used on report pages to show the full phenotype of a 
cell type.  For example, the CD4 phenotype is shown as "CD4: CD66b-CD3+Cd8-CD4+CD14-
TCRgd-CCR7+>-CD27+>-CD45RA+>-" 
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What is a Probabilit y State Model?  

  

Flow cytometry data analysis focuses on identification of populations in a sample and 
providing statistical results about those populations. Typically, regions drawn on plots are 
used to create a hierarchy of subsets by "gating" the events . The subsets are analyzed for 
frequency, intensity, and other common statistics to characterize the cells that were 
analyzed. 

GemStone approaches data analysis quite differently by using a Probability State Model 
(PSM) to identify and quantify subsets. So what is a Probability State Model, and why is it a 
better approach? 

Let's examine the words that make up the name to get an idea of what a PSM is:  
  

Probability : the statistical likelihood of a particular event occurring. A  PSM classifies events 
using probabilities rather than gates. Gating is subjective, and relatively small errors made in 
drawing gates are compounded with each subsequent gate in the hierarchy. By using 
probability, a PSM actually reduces the error with eac h additional measurement that is added 
to the model. The likelihood that you are actually identifying the cells you are interested in 
increases as you build a PSM. 
  

State : a set of conditions that discretely characterize something. A PSM classifies events into 
a set of states, based on the characteristics defined for each measurement. GemStone uses 
the state as the common, X-axis for its expression plots. This allows all measurements to be 
compared on a common axis, making it possible to correlate all measurements in a single 
plot. 
  

Mod el : a mathematical representation of a process. A PSM uses fitting routines to classify 
cells into the most probable states and cell types. Using this approach, GemStone can 
provide objective assessment of how well the model represents the data. There are no hard-
edges in a PSM. The modeling process allows populations to overlap based on probabilities. 
  
A PSM allows us to classify events into populations based on a model that we define. The 
model is made up of one or more cell types, where each cell type defines a subset that we 
want to analyze. We use what we know about the markers in our experiments to create a set 
of expression profiles for each subset. An expression profile uses a set of control points to 
define how the subset transitions over the state  axis. The state axis is typically labeled 
"Progression", but it does not have to be a progress at all. In fact, simple models can be 
designed to identify and quantify cell populations where the parameter profiles are simply  set 
for constant intensities. 
  
With the PSM approach, we can measure and report confidence limits. We can evaluate the 
goodness-of-fit with reduced chi -square (rcs). And we can co-plot our parameters in a single 
graphic that allows us to examine the coordinated transitions of markers in the cells we 
analyze. 
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Tutorials  

Analyzing Files with an Existing Project  

Overview  

In this tutorial, you will use a previously -created GemStone Project to analyze FCS files from 
a 16-color immune profiling panel. The Project was designed to identify seven cell types and 
to present a report with a summary table and details for each cell type.  

You will add files to this project and analyze them with just a few clicks. The results that you 
see can be reproduced if you or someone else runs the analysis again. The approach is 
simple, fast, and reproducible. 

Let's give it a try!  

  

Start GemStone  

Start Gemstone by following the instructions in the Installation and Setup of GemStone 
section. 

  

Create a N ew Project  

On the Home tab, click the New Project button to create a new Project. 

 

  

In the New Project dialog, select Example 16 Color  in the Based on  field. This will create a 
new project based on the selected project.  

For Project Name  you can leave the suggested name or type your own. 

Click OK. 

 

  

Add FCS Files  
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Next, you will add files to analyze. Click the Add FCS Files button on the Home tab. 

 

  

In the Select FCS Files dialog, navigate to the Tutorials folder of the GemStone 
workspace.  Select the three files 16-color_1.fcs, 16-color_2.fcs, and 16-color_3.fcs. Click 
Open . 

 

  

The files are added to the batch list in the left p anel of the program.  

At this point, you are ready to analyze these files automatically with the example 16 -Color 
immune panel project. 

  

Analyze the Files  

The First File  

Let's analyze the first FCS file. 

Click the Run  button in the Processing group on the Home tab. This tells GemStone to follow 
the steps in the batch script to read and analyze the selected file.  
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The software first opens a template document, which defines the analysis for seven cell 
types, along with the plots and report pages. Once the template is opened, the FCS file is 
read into the template.  

The auto-analysis step is next. In this step, each of the defined cell types is adjusted to the 
data in the FCS file. The status pane at the bottom of the main window indicates which step 
of the analysis is being performed. 

 

  

When the process is complete, the summary page of the report presents a table of the key 
results of the analysis.  

 

  

At the bottom of the main window, th ere are tabs for each page in the analysis report. To 
review a page, click the tab.  

 

  

For example, click the CD4 T tab to review the analysis of CD4 T cells. 

The report shows the name of the cell type and its phenotype at the top. The Selection 
Markers section shows several plots for the measurements that were used to identify CD4 T 


































































































































































































































































































































































































































































































































































































































































































































































































































































































































































